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A.  Introduction 
 
All degree candidates are required to follow the formatting guidelines.  Please do not use 
old USC theses or dissertations as examples since errors may have been overlooked or 
the guidelines may have changed.  The Graduate School has not created and does not 
endorse any software programs or templates, even if such programs exist at the 
school/departmental level.  LaTex users may request a style sheet from the Graduate 
School with the understanding that editors cannot advise students about any deficiencies 
it may have regarding the Guidelines.  Graduate School thesis editors give format 
corrections only.  Content may not be changed once a manuscript is approved by 
committee and submitted to the Graduate School (exception: typos).  Once a manuscript 
is approved by the Thesis Editor, no further corrections, including typos, are permitted. 
 
Once a manuscript has been submitted to the Graduate School (initial submission), 
absolutely no more content or committee-mandated changes can be made to it.  If a 
student wishes to continue working on the manuscript, it will be pulled from the editing 
queue and the student will be required to register for thesis/dissertation units and/or pay 
late fees. The student will only be able to (re)submit for the following semester.   
 
All manuscripts are read and paperwork is processed in the order received.  Degrees are 
posted by Degree Progress on a rolling basis once the manuscript’s format has been 
approved and the Thesis Editor has signed off on the paperwork.  Thus degrees may post 
to your academic record earlier than the conferral date if submitted well before the 
deadline.  All students who submit near or at the deadline are eligible to have their 
degrees post if their paperwork is in order and their corrections are made in a timely 
manner before the degree conferral date.   
 
The Graduate School cannot write and issue letters verifying near-completion or 
completion of the degree for any purpose including prospective employer requests. 
Consult your department advisor/department chair or dean’s office for assistance.  
 
B. Deadlines 
 
Degrees are conferred three times a year: at the end of the fall and spring semesters and at 
the end of the last summer session. All submission deadlines will be strictly enforced.  
There are no exceptions.  Students should schedule their defenses in time to make all 
the content changes and corrections that may be required by their committee as well as to 
obtain the necessary signatures and format according to the Guidelines in advance of any 
deadlines.   
 
The submission deadlines refer to the initial submission of the manuscript after you have 
made all your committee-required changes and formatted it according to the Guidelines.  
The submission deadlines are NOT editing approval deadlines.   
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The following submission steps are all required: 
 

1. Students must create and complete (3 pages) a profile on the USC Thesis and 
Dissertation Online Processing Web site in the semester they anticipate filing 
their manuscript with the Graduate School.   

2. Students must submit all their completed graduation paperwork in person to the 
Graduate School by 5:00 p.m., Pacific Standard Time by the deadline date.  

3. Once cleared, students must also submit their manuscript electronically by 11:59 
p.m., Pacific Standard Time by the deadline date. 
 

Only students who submit their paperwork for a particular semester’s deadline will be 
cleared to submit their manuscript electronically.  All manuscripts submitted without 
paperwork (or incomplete paperwork) will be rejected and the student will be 
automatically disqualified from being eligible for a graduation date in a desired term. 
 
Turning in a manuscript by the deadline date and time does not guarantee that a 
student will be awarded the degree in the corresponding term; it only makes a 
student eligible for that graduation date.  
 
A student’s graduation date will be advanced to another term if:  

1. The student fails to make all his/her corrections in the time allotted 
2. The student fails to make all his/her corrections by the conferral date 
3. The student’s paperwork is incomplete and/or lacking original and authorized 
signatures 

A student will be awarded a graduation date for the term in which he/she academically 
and administratively fulfills all requirements for the degree (regardless of the submission 
date), including the approval of a final version of the manuscript and the submission and 
verification of all supporting documents, as well as the completion of any outstanding 
degree requirements.  Degrees will not be awarded retroactively. 
 
C. 594/794 (Thesis/Dissertation) Registration Rules (domestic students only)  

 
The following is IMPORTANT information about registration in thesis and dissertation 
units and deadlines for submission of the thesis or dissertation.   
 

http://www.usc.edu/dept/GRADSCHL/downloads/4_Rules_Governing_Registration_594_794.pdf 
 
Students wishing to avoid registration in 594, 794 or the equivalent (once they have met 
the minimum registration requirements in these units) must first submit their 
completed and signed graduation paperwork to the Graduate School and then, once 
cleared, upload their manuscript to the Graduate School by the add/drop date of the fall or 
spring semesters (end of the third week of classes). Students who do not submit by their 
completed graduation paperwork and manuscript by the add/drop deadline date and times 
will be required to register in 594, 794 or the equivalent.   
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D. Documentation 
 
The following documentation items must be submitted to the Graduate School before a 
student will be cleared to upload the manuscript.   
 

1. Approval to Submit Defended and Final Copy of Doctoral Work or Approval 
to Submit Final Copy of Master’s Thesis form (replaces Final Typing Card): 

a. Signed by the entire committee and dated by the chair only after the satisfactory 
completion of the thesis/dissertation defense and all post defense revisions. 
Unanimous approval of the committee required.  
 

2. Verification of the Completion of the Requirements for the Doctoral 
(Master’s) Degree Form (replaces Triple Cards): 

a. Signed/dated by the Graduate Staff Advisor and Dean of the conferring unit, 
Department Chair or Director (Master’s or Ph.D. Program Director). 

b. Staff Advisors may submit this form after the student uploads the manuscript.  
However, without it, a student will not be cleared to graduate.  

 

3. Documentation Review Form (Checklist): 
a. Signed/dated by both the student and the Graduate Staff Advisor.  

 

4. Signature Page: 
a. Use the signature page appropriate for your degree and school.  
b. Signed by the committee and for non-Graduate School degrees, also signed and 

dated by the Dean of the conferring unit (exception M.S., ENGR – dean does not 
sign, only the committee).   

c. Do not include the signature page in the PDF file.  
d. The signature page will be sent only to the USC Libraries (for inclusion in the 

Electronic Archives). The signature page will not be sent to ProQuest. Copies of 
the signature page will not be distributed.  

e. For degrees under the jurisdiction of the Graduate School, the Vice Provost for 
Academic Affairs and Graduate Programs will sign and date the signature page 
once you have completed the editing process.  The committee chair should not 
date the signature page.  

 
5. Publication Fee Receipt of $115 (Doctoral) and $105 (Master’s):  

a. Payment is accepted at the Cashier’s Office – UPC and HSC.  
 

6. Survey of Earned Doctorates: 
a. Completed by all doctoral students.  The results are used by governmental and 

private agencies to support new and existing educational programs.  
 

7. Copy of the Appointment/Change of Committee Form indicating most current 
committee of record: 

a. Applicable for all Ph.D. and Master’s degrees under the jurisdiction of the Graduate 
School (Appendix F). 

b. The Request to Take the Qualifying Exam is not sufficient. 
c. The form must be signed by the Dean of the school which administers your degree. 
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E.  Manuscript Formatting  
Manuscripts must be electronically formatted on 8.5 x 11 inch "paper size” in black text 
font. Color is permitted only in tables and figures.  Only black text can be used to 
describe tables and figures. Oversized pages are not permitted.  
 
1.  DISSERTATION/THESIS REQUIRED ELEMENTS AND ORDER 
 
Table 1 identifies a list of required and optional elements for all degree candidates.  
Students submitting a musical score are exempt and should consult Appendix H for a list 
of required and optional elements. Master’s students in Journalism must follow this table 
with minor exceptions (Appendix H). 
 
Table 1: Dissertation/Thesis Elements and Their Order 

Order Element Required-
Optional 

Pagination Table of 
Contents Entry  

1 Title Page Required unnumbered No 
PRELIMINARY  PAGES

2 Epigraph Optional If first page, start with small 
Roman numeral ii (preliminary 
pages use Roman numerals) 

Yes 

3 Dedication Optional Small Roman numeral Yes 
4 Acknowledgments Optional Small Roman numeral Yes 
5 Table of Contents Required Small Roman numeral No 
6 List of Tables 

(if there is more than one table) 
Required Small Roman numeral Yes 

7 List of Figures 
(if there is more than one figure) 

Required Small Roman numeral Yes 

8 Abbreviations Optional Small Roman numeral Yes 
9 Abstract Required Small Roman numeral Yes 
10 Preface Optional Small Roman numeral Yes 

MAIN PAGES/BODY
11 Main Body Required First page of introduction or first 

chapter starts with Arabic no. 1  
Yes 

12 Glossary Optional Arabic numeral Yes 
13 Alphabetized Bibliography Required Arabic numeral Yes 
14 Appendices Optional Arabic numeral Yes 

 
I. Title Page (See Appendix D) 
 
II. Preliminary Pages 
 
Headings: All headings in this section must consistently formatted in the same size, style 
and font, including the Abstract and the Table of Contents.  Note: You should use the 
same style for headings throughout the manuscript. Headings must match what is 
indicated in the Table of Contents page.  
 

A. Epigraph, Dedication, Acknowledgements and/or Preface 
 
1. Text must be double-spaced; no italics.   
2. All of these preliminary pages must have a heading and all headings must match 

the same size, style and font of the other headings in the preliminary pages.  
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B. Table of Contents (Appendix B) 
 

1. Single space entries; double space between main entries and chapters. 
2. Include page numbers for every Table of Contents entry.  
3. Do not use multiple or bold fonts. (You may bold main chapter headings but not 

page numbers). 
4. Do not italicize or bold page numbers.  
5. Align page numbers properly to the right margin. Do not allow text to enter the 

column of page numbers.  
6. “Dot leaders” are not recommended.   
7. Do not include a secondary heading over the sections and page numbers.  
8. List only the first page where a chapter starts (not the entire range of a chapter).  
9. Multiple subheadings are acceptable, but not in excess.  
10. Include subheadings and corresponding page numbers in the listing of appendices.  
11. NOTE: Update after all format editing is complete - include all headings & 

subheadings.  
 

C. List of Tables/Figures (Appendix C)  
 

1. If you have more than one table/figure, include full table/figure titles and the 
corresponding page numbers.  

2. Do not group List of Tables and List of Figures.  Each list must be on a separate 
page.  

3. Single space the entries; double space between entries.  
4. Do not italicize or bold page numbers.  
5. Align page numbers properly to the right margin.  
6. Do not allow text to enter the column of page numbers.  
7. If you have only one table/figure, include it in the Table of Contents under its 

chapter.  
8. Do not include a secondary heading over the sections and page numbers. List only 

the first page where a table/figure starts (not the entire range of a table/figure). 
9. NOTE: Update after all format editing is complete.   

 

D. Abbreviations, Glossary (Check Table 1 above for location) 
 
1. Single space entries; double space between entries. 
 
E. In-Text Abstract   
 

1. An in-text abstract is required – no limit on the number of words. 
2. Text must be double-spaced.  No italics.  
3. ProQuest and the USC Libraries require the submission of an abstract during the 

uploading process.  ProQuest places restrictions on the number of words per 
abstract which is uploaded separately from the main manuscript.  No limit 
exists for the USC Libraries.  
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III. Main Pages 
 
Headings:  All headings in this section must be consistently formatted in the same size, 
style and font (including consistent changes in format for sub-headings).  Note: This 
includes the headings for the preliminary pages.  
 

A. Body:  
 
1. Double space throughout, except for block quotations, which should be single-

spaced. 
2. Avoid spacing that is greater or wider than regular double-spacing. 
3. Manuscripts should have numbered chapter headings that are listed in the Table of 

Contents.  
4. Do not give Bibliography or Appendices a chapter number. 
5. Tables and Figures:  Use the same heading size and font style; all captions must 

be in the same heading size and font styles.  
6. Running headers/footers are not permitted.                                                                                      

 

B. Alphabetized Bibliography 
 
1. An alphabetized bibliography comprehensive to all chapters at the end of your 

manuscript is required regardless of whether you have chapter endnotes or 
chapter reference sections. 

2. A bibliography is required even though your discipline does not require it.  
Exception: musical scores and some professional projects in journalism  

3. Bibliographic entries must be presented in alphabetical order by the first author's 
last name.   

4. Do not allow bibliographic entries to split over pages; each entry must be 
complete on one page. 

5. If you chose to have a reference page at the end of each chapter, a comprehensive 
bibliography (combining all reference pages) is still required at the end.  

6. If you use numbered citations in the body, you can retain the numbers in the 
bibliography, but present the references alphabetically. In other words, the 
references will be in alphabetical order, but not in numerical order. 

7. Use a citation method appropriate to your degree for the formatting of footnotes 
or endnotes.  The Graduate School does not endorse a specific citation style, but 
you can use only one style throughout the manuscript. 

 
C. Appendices  
 
1. Headings must match all other headings in preliminary pages and main body.  
2. Appendices must follow the guidelines in terms of pagination and margins, but 

may include alternate spacing or fonts.  
3. Appendices must follow the guidelines in terms of pagination and margins, but 

may include alternate spacing or fonts. Exception: Headings must match all other 
headings in preliminary pages and main body.  
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2.  MARGINS 
 
All text, including tables, figures, page numbers and appendices must fit within the 
margin requirements on every page.   The required minimum margin settings are. 

• Top:  1 inch 
• Bottom:  1 inch 
• Right:  1 inch 
• Left:   1.5 inches 

 
3. PARAGRAPHS & JUSTIFICATION 
 
To indicate a new paragraph, either indent the first line of the paragraph or double space 
between paragraphs.  Manuscripts may be justified at the left margin, or at both margins. 
 
4. HEADINGS 
 
All preliminary page and chapter headings (dedication to appendices) as well as table and 
figure headings must be consistent in font size, typeface, placement, and style.  
Subheadings can be different than the main headings, but all subheadings must be 
consistent in font size, typeface, placement, and style.  
 
5. FONT & TYPEFACE 

 
Use same (readable) font (at least 10 point) throughout the manuscript, including block 
quotations. Do not bold text unless indicating a new heading.  Exceptions: 
  

a. Chapter titles/section headings may be 2 to 4 points larger than the body font. 
 

b. Footnotes, endnotes, and text appearing in tables and figures, including labels, 
legends, and captions, may be as small as 9 point. 

 
6. PAGE NUMBERS 
 

a.    All pages must be numbered consecutively in the same location and in the 
same orientation including the first page of every chapter/section and the 
appendices, with the exception of the Title Page (see Table 1 above).  
 
b.    Page numbers must be placed either in the top right or bottom right side of 
the page (centered [pages] numbers not accepted).  Page numbers MUST fit 
within the margin requirements and measure at least an inch from each edge 
(adjust header/footer depending on the location of the page number to 1.0). 

 
c.     All page numbers, including those of the appendices, must be of the same 
font and size as the body font, in plain font style (no bold or italics). They must 
not include periods, hyphens, parentheses or running page headers or footers.  
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d.    At least one double space MUST separate every page number from any text, 
tables, figures or footnotes. For page numbers in the top right corner, the first line 
of type should be one double space below.  For page numbers in the bottom right 
corner, the last line of type should be one double space above (see Figure 1).    
 
e. Though tables and figures may be “landscaped,” or presented sideways on the 
page, page numbers may not be landscaped. All page numbers must be 
oriented in the same direction throughout the manuscript. 

 
 
Figure 1:  Page Number Location 
 

Header: 1.0” 
    11 
  Dfkadfjlkjflaflafjladjfdfdadda Dfjk  
Ddfadfdafadfadfdfadffdafgbbb 
Fads Dfadsfdasfadfadfadfabttreeeee 
Fadsf Kjhiuohnadfalikbsrfkerasdfads 
 
 

 
 Dfkadfjlkjflaflafjladjfdfdadda 

            Dfjk Ddfadfdafadfadfdfadffdafgbbb 
 Fads Dfadsfdasfadfadfadfabttreeeee 
 Fadsf Kjhiuohnadfalikbsrfkerasdfads 
 
   12 
Footer 1.0” 

 
 
The ProQuest technical support page provides instructions on how to handle landscaped 
tables and portrait pages.  See the “Submitting and Revising” section of:  
http://www.etdadmin.com/cgi-bin/main/faq 
 
7.  SPACING 
 
All text throughout the body of the manuscript must be double spaced. This includes 
the acknowledgements, dedication and abstract pages.  It also includes a double space 
between the page number and the first line of text (if the page number is on top of the 
page) or the last line of text (if the page number is on the bottom of the page). 
Exceptions: 
 

a. Block Quotations:  Quotations of 40 words or more should be single 
spaced and indented in block from the left margin.  Do not use quotation 
marks unless you are indicating a dialogue. 

 
b. Table of Contents & List of Tables/Figures: Double space between 

entries; single space between entries.  Subheadings may be single spaced 
when paired with a main heading.  

 
c. Tables and Figures within the Manuscript:  Single space text in tables 

and figures, including table and text figure captions, legends, and notes. 

If page number is on the top right corner, it must be 
located below the header (within the top and right margin 
requirements) and at least one double space should 
separate the page number from the first line of text.  

If page number is on the bottom right corner, it must be 
located above the footer (within the bottom and right 
margin requirements) and at least one double space 
should separate the page number from the last line of 
text.  
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d. Footnotes and Chapter Endnotes:  Single space footnotes and chapter 

endnotes; double space between chapter endnotes and footnotes.  
 

e. Bibliography Entries: Single space entries; double space between entries. 
 
8. WIDOWS AND ORPHANS 
 
A widow occurs when the last line of a paragraph is the first line of a page. To eliminate 
a widow, add a space to the previous page so that the last two lines of the paragraph 
appear at the top of the next page.  An orphan occurs when a heading or the first line of a 
paragraph is the last line of a page. To eliminate an orphan, add an extra space to that 
page so that the heading or first line of the paragraph falls on the next page.   
 
Figure 2:  Widows and Orphans 
 
 

pjfskj' pojpokj dkfjalkjlasjflakdsjlaadfkdljlakjladkjlkaddl 
       

         Adfadhdajskfhadkjshadksjahkdshjad ffadskfjadlfkjaldkfjaldfjadksfjadlfj 

Fdkasdlfjaldskjaldkjadlsjadslkjadslkfjadlksfjadlfkjadslkfjadslkfjadslkfjakldsf 

Dakfjaldkjaldkjladkjladkjaldkjadklfd 

 

       Bowj ofpikwioj  lojf pokj o po poj r  pogj epoje owg pogk asdlfkdasljfkjdal 

spowerr.oplkm, nhndbhpoj .oplkm, nhndbh bgv vfcd xsza sqwqw. Aldfkjadlkjaldjlkad 

kdfjlakjlakjldakjladksjlkadsjlakjlajkladkjladskjldaskjlaskjaldskjaldskjladksjlakdsj 

 

        Na lI d kj lkjlk qouat Lands Caldder 
 
 
9. TABLES AND FIGURES 
 

a.   All tables and figures must fit within the margin requirements and must be  
                  formatted on 8 ½ by 11 "paper size."                    
 

b.   Each table and figure must have a number and heading, and must be listed in 
the Table of Contents (if you have only one table or figure) or in the List of 
Tables or the List of Figures (if you have more than one table or figure). 
Tables and Figures located in the Appendices must also be numbered and 
listed] 

 
c.   All table (figure) headings, captions and legends must be consistent in 

style and size with all other table (figure) headings, captions and legends.  
Number consecutively throughout the document or use chapter number 
prefixes and number consecutively within each chapter.  

 
d.   Each table/figure must be placed as close as possible to the place in the body 

where mentioned, not at the end of a chapter or at the end the manuscript or in 
the appendices.   

widow line 

orphan line 
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e. If a table or figure crosses over two pages, it must repeat the table/figure 
number at the top of the page and include the word “continued” (i.e., Table 1, 
Continued). 

 
f.   Table and figure headings, captions, notes or legends should be on the same 

page as the table or figure.  Lengthy table and figure headings (with their 
accompanying captions, notes, and legends) which do not fit on the same page 
may be placed by themselves on a separate page immediately preceding the 
table or figure. This is called a “half-title page.” Half-title page headings and 
text should be double-spaced. 

 
g. Wide tables and figures may be landscaped, or placed sideways. Landscaped 

tables/figures must face out of the 1.5 inch binding page, with the top of the 
table/figure at the left margin.  Page numbers must not be landscaped.  

 See: http://www.etdadmin.com/cgi-bin/main/faq 
 
Figure 3:  Landscaped Table 
 

      Header: 1.0” 
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  Left Margin 1.5              

                             34 
Footer 1.0 

 
 
 
 
 
 
 

If page number is located at the 
top of the page, at least one 
double space must separate 
page number from any text, 
including tables and figures.  
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If page number is located at the 
bottom of the page, at least one 
double space must separate 
page number from any text, 
including tables and figures.  

* Left margin (1.5) represents 
the top of the table/figure 
 
* Landscaped Table/Figures must 
face out 
 
* Page numbers may not be 
landscaped on pages with a 
landscaped table 
 
* With the exception of the table 
title and description, all text must 
be in the portrait position 
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10.  FOOTNOTES AND CHAPTER ENDNOTES 
 
a.   Endnotes must appear at the end of each chapter (not at the end of the 

manuscript) and start on a separate page with the heading “Chapter X 
Endnotes.” Include an entry in the Table of Contents for each endnote section.  

 
b.   Footnotes must begin on the same page where indicated in the next.  Some 

computer programs may place the footnote on a different page, which must be 
changed manually.  

  
c.   Single space footnotes and chapter endnotes; double space between chapter 

endnotes and footnotes.  Format all footnotes/endnotes consistently.  Number 
them consecutively and do not use italics.  

 
d.   Page numbers should not “crash” into your footnotes; they must be separated 

by at least one double space.  
 

e.   Use a citation method appropriate to your degree for the formatting of 
footnotes or endnotes.  The Graduate School does not endorse a specific 
citation style, but you can use only one style throughout the manuscript.  

 
11. CHAPTERS 
 

 a.   All manuscripts must be divided into chapters.   
 

b.   Each chapter must begin on its own separate page.  
 
c.   Chapter title headings should appear on the first page of a chapter; not on a 

separate page.  The wording must match the exact wording in the Table of 
Contents entries including “Chapter [number].”  

 
d.   Chapter title headings should be consistent (font size, placement, etc…) 

throughout the manuscript.  
 
e. The bibliography/reference page is not considered a chapter. The introductory 

and concluding parts of a manuscript are considered chapters.  
 
f.    Musical scores do not need to be divided into chapters.  However, musical 

scores must follow the general formatting guidelines. See Appendix H.   The 
preliminary page requirements still apply.  

 
12. SCREENSHOTS, PHOTOGRAPHS, WEB LINKS & SUPPLEMENTAL 

FILES   
 

a. Screenshots (from a web-based project) and photographs are permitted in a 
manuscript provided that they fit within the margin requirements and 
appropriate citation methods are used.  
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b.   Screen shots and photographs should be treated as figures and each figure 
should be listed in the List of Figures.  

 
c.  Photographs should be presented as clearly as possible.  Note any changes to 

the image as a result of the PDF conversion.  
 

d. Web links (URLs) are permitted provided that they fit within the margin 
requirements.  Note: Web links may change and/or may no longer be valid 
post publication.  

  
e.  Only PDF versions of a manuscript may be uploaded.  ProQuest and the USC 

Libraries allow you to upload supplemental files such as video clips, 
collections of images (JPEGS), etc. that cannot be integrated into the main 
body of the thesis or dissertation. Students should be prepared to do this when 
they are creating their account with ProQuest and the USC Libraries and ready 
to upload their main document (as well as the abstract text which is separately 
done from the main document).  
 

F. Conclusion 
Students are responsible for familiarizing themselves with the Guidelines and the 
required graduation paperwork as well as the submission deadlines for both the 
paperwork and the manuscript.  Students have the primary responsibility for formatting 
their own thesis/dissertation.  Graduate School thesis editors cannot submit paperwork or 
upload documents for students, make corrections to documents, or advise students how to 
accomplish a particular formatting task with their chosen computer software programs.  
Students are expected to (1) make a good faith attempt to review and to understand the 
Guidelines; (2) make a meaningful effort to format their document accordingly; and (3) 
check the converted PDF version after uploading it to ProQuest for review.   
 
While formatting is not difficult it can be time consuming.  Students with time constraints 
and busy work schedules should plan accordingly.  Exceptionally busy students with 
complex formatting tasks (such as numerous tables and figures) may wish to delegate all 
or some of their formatting to a private editor.  Students who want editorial assistance in 
revising their writing for clarity, grammar and usage should also research private editorial 
services.  Note that just before submission deadlines private editors may already be very 
busy and unable to accommodate additional clients. 
 
If a first PDF is submitted with multiple basic formatting errors so that it is clear a 
student has not reviewed the Guidelines or made a good faith effort to meet them, the 
thesis editor will send a NONSPECIFIC correction advice requiring the student to 
reformat according to the Guidelines and to resubmit.  This is considered to be the 
document's first review.  Requests for an itemized list of corrections will NOT be granted 
until the student uploads a second PDF that has been significantly revised to better meet 
the Guidelines and the editor is able to do the second review.  A very poorly formatted 
initial PDF submission and subsequent untimely delays in resubmitting revised PDFs 
may jeopardize a student’s chances of graduating in an expected term.   
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APPENDIX A: 
BASIC FORMATTING TIPS 

 
The following is a list of basic formatting tips.  Please be advised that it is not comprehensive.  Students are 
still expected to read and follow the University’s Guidelines 
 

1. Title Page 
o Follow the sample title page in the Guidelines for your degree/major 
o Must meet margin requirements 
o Title Page SHOULD NOT include your defense date or the list of your committee 

members 
o Title ALL CAPS and DOUBLE-SPACED 

� Note: Your title page must include your own thesis/dissertation title, not the 
sample title on the sample title pages in the Appendices 

o Your name must not be in all CAPS 
� Note: Your title must include your own name, not the sample name on the 

sample title pages in the Appendices.  
o Do not capitalize “b” in “by” 
o Word Accuracy and Spelling. Note what words/phrases must be in all CAPS and what 

words or phrases must begin with Caps 
o Graduation date is either December, May or August (200X) 
o Copyright line must be included (regardless of whether formal copyright is requested) 
o One font size throughout/No bold permitted 
o “Presentation” paragraph correct – Thesis/Dissertation must be “presented” to the faculty 

of the conferring unit.   
o Spacing requirements followed; include horizontal line (do not allow the line to violate the 

margin requirements 
 

2. Margins 
o Top:  1.0 inches 
o Bottom:    1.0 inches 
o Right:  1.0 inches 
o Left:  1.5 inches 

 
ALL printing - including title page, text, words, lines, paragraphs, tables and the figures (plus 
descriptions), page numbers, footnotes, endnotes MUST fit within the margin requirements.  

 
3. Page Numbers 

o All pages numbers (from preliminary pages to the end) must be placed in either the top 
right or bottom right corner (includes pages with landscaped tables) 

o Every page (from the preliminary pages to the end, including the appendices), must be 
numbered consecutively 

o All page numbers must be consistently placed throughout the manuscript and must fit 
within the margin requirements (adjust header or footer to 1.0 so that the page number 
falls below/above the header/footer)  

o Double space must separate page numbers from any text, including tables and figures 
o On pages with landscaped tables, page numbers cannot be landscaped.  They must 

remain their portrait position.  
 

4. Preliminary Pages 
o Begin on page roman numeral page ii 

� Title Page (stands unnumbered) 
� Dedication or Acknowledgements (optional) 

� If included, requires heading (“Dedication” or “Acknowledgements”) and 
an entry in Table of Contents 

� Text MUST be double-spaced 
� Table of Contents (required) 

� Does not require an entry in the Table of Contents 
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� List of Tables (required if there is more than one table) 

�  If included, requires an entry in the Table of Contents 
� List of Figures (required if there is more than one figure) 

�  If included, requires an entry in the Table of Contents 
� Abstract (required) 

� Requires an entry in the Table of Contents and a Heading (“Abstract”) 
� Text MUST be double-spaced 

 
5. Headings 

o All headings (preliminary pages to the appendices) must be consistently placed and 
similar in style to the previous headings in terms of capitalization, font style, and typeface. 

 
6. Table of Contents/List of Tables/List of Figures (Appendix B and Appendix C) 

o Page numbers must be aligned in a straight column, to a common tab. Text cannot enter 
the column of page numbers of the manuscript 

o Single space each list entry; double space between list entries 
o A separate List of Tables/List of Figures is required if you have more than one table/figure 

(do not group the List of Tables and List of Figures together) 
o Include subtitles to appendices section 

 
7. Tables and Figures 

o All table and figure headings & descriptions/captions must be consistent throughout the 
manuscript in terms of location (top or bottom of table/figure) and presentation 
(capitalization, font style, and typeface) 

o Table/figures must fit the margin requirements 
o Landscaped tables must face out with the top of the table falling on the left margin (1.5”) 
o On pages where there is a landscaped table, landscaped page numbers ARE NOT 

permitted 
 

8. Body 
o Choose one font size and use throughout 
o All text, including dedication, acknowledgments and abstract pages, MUST be 

doubled space (except block quotes) 
o Running Headers/Footers are not permitted 
o Widows/Orphans not permitted 
 

9. Bibliography 
o Required for all majors (except: musical scores and a select number of manuscripts 

from the Journalism program – see Appendix H).  
o Must be organized alphabetically by the (first) author’s last name 
o Single space each bibliography entry; double space between entries  
o Each bibliography entry must be complete on one page; do not allow an entry to split over 

pages 
o Comprehensive bibliography required even if you have separate reference pages at the 

end of each chapter.  
 

10. Appendices 
o Page number and margin requirements must be met 
o Can use any spacing and different font size and styles (exception: heading, which must 

match previous headings used throughout the manuscript) 
o Include subheadings in the appendices section of the Table of Contents (Appendix B) 

 
11. Citation 

o For footnotes, endnotes or bibliography, use a citation method appropriate for your degree 
and be consistent throughout the manuscript. 
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APPENDIX B: 
SAMPLE TABLE OF CONTENTS 

 
Table of Contents  

 
Title                   Page No.  
 
Dedication (optional)         ii 
            
Acknowledgements (optional)       iii        
        
List of Tables (required if there is more than one table)    v 
            
List of Figures (required if there is more than one figure)    vi 
 
Abstract (required)                                                                                                     vii 
 
Introduction: Guidelines        1 

Dissertations         10 
Theses          39 

 
Chapter 1: Margins         40 

Bottom Margins        45 
Top Margins         75 
Chapter 1 Endnotes        92 

 
Chapter 2: Page Numbers        93 
 Roman Numerals        97 
 Arabic Numerals        120 
 Chapter 2 Endnotes        125 
         
Conclusion          130 
 
References or Bibliography (required)      133 
 
Appendices: 

Appendix A: Letter to Editor       141 
Appendix B: Letter to Author       142  

           
Chapter 1: Margins             40-92 
 
     
 
(paginate using roman number)                                  iv 

Secondary headings are not 
permitted 

List only the first page a chapter starts, not the range 

Single space each list 
entry; double space 

Do not align corresponding 
page numbers with main 
page number  

Must read “Table of Contents,” not 
just “Contents” 

Include  
subheadings 
and indent 
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APPENDIX C: 
 SAMPLE LIST OF TABLES (OR FIGURES) 

 
 

List of Tables (Figures) 
 
           
 
 
 
Table/Figure Title               Page No.  
 
Table 1: Widows and Orphans       45 
 
Table 2: The Effect of Widows and Orphans on the Presentation   101  

   of Theses and Dissertations at USC 
 
Table 3: Dissertation/Thesis Elements      105 
 
Table 3: Dissertation/Thesis Elements (Continued)     106 
 
Table 4: How to Create Landscaped Tables         107-109 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
 
 

(paginate using roman number)         iv        

Secondary 
headings are not 

permitted 

List only the first page a 
table/figure starts, not the 
range 

Do not list the same table/figure 
twice if it goes over two pages in 
the List of Tables/Figures 

Single space each list 
entry; double space 

Do not align corresponding page numbers with main 
page number  

Include title of Table/Figure as 
it appears in the text 

Headings should match the 
headings of preliminary 
pages in terms of font, size 
and style 



17 
 

APPENDIX D:  
SAMPLE TITLE PAGES 

 
Title Page Instructions 
 

1. Margin Requirements 
Left: 1.5 Top: 1.0 
Right 1.0 Bottom: 1.0 

 
2. Note the spacing requirements within and between sections.  
 
3. Put horizontal line approximately in middle of page.  Make sure that the line fits within the 

margin requirements. 
 

4. Title must be double-spaced; presentation paragraph must be single-spaced.  
 

5. Note what words need to be in ALL CAPS and which words need to use initial caps.  Do 
not capitalize the “b” in “by.” 

 
6. Choose either 11 or 12 point font, and use the same font throughout the page. 

 
7. Do NOT use bold typesetting. 

 
8. Your expected graduation month must be December, May, or August.  Please do not 

use any other dates, such as a defense date.  Use month only, not a day, i.e., May 2010.  
 

9. Do not include any extra information, such as the names of the committee members. 
 

10. Check Catalog for the proper title of your major. 
 

11. Include the copyright line regardless of whether a claim of copyright is requested. 
 

12. Title page is unnumbered. 
 
13. Samples Included: 

 
• Ph.D., Graduate School 
• Ed.D., Education 
• D.M.A., Music 
• D.P.A., and D.P.P.D., Policy, Planning and Development 
• M.S./M.A., Graduate School 
• M.F.A., Graduate School (The M.F.A. is NOT conferred by the School of Fine Arts).  
• M.B.S. or M.L. Arch., M.H.P, Architecture 
• M.P.A.S., Fine Arts 
• M.S., Education; Master of Education; Master of Marriage and Family Therapy 
• M.S., Engineering 
• M.S., Gerontology 
• M.M., Music 
• M.F.A., Cinematic Arts (Interactive Media) 
• D.R.S., Pharmacy 
• M.A., (Traditional Journalism and Specialized Journalism) 
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SAMPLE TITLE PAGE FOR PHD DEGREES CONFERRED BY  

THE GRADUATE SCHOOL 

 
YOUR TITLE IN CAPS; 
DOUBLE SPACED 

 
 
 

by  
 
 

Tamara Alice Trojan 
 
 

 
 

 
 

 
A Dissertation Presented to the  

FACULTY OF THE USC GRADUATE SCHOOL 
UNIVERSITY OF SOUTHERN CALIFORNIA 

In Partial Fulfillment of the 
Requirements for the Degree 

DOCTOR OF PHILOSOPHY 
(ENGLISH)  

YOUR MAJOR IN CAPS 
 
 
 

         December 201X 
OR May OR August  

 
 
 

 
 
Copyright 200X                    Tamara Alice Trojan 
 

 
 

 
Page number not included 
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SAMPLE TITLE PAGE FOR EDD DEGREES CONFERRED BY 

 
THE ROSSIER SCHOOL OF EDUCATION 

 
YOUR TITLE IN CAPS; 
DOUBLE SPACED 
 

                  
by 
 
 

Tamara Alice Trojan 
 
 
 
 
 
 
 
 
 

A Dissertation Presented to the  
FACULTY OF THE USC ROSSIER SCHOOL OF EDUCATION 

UNIVERSITY OF SOUTHERN CALIFORNIA 
In Partial Fulfillment of the 

Requirements for the Degree 
DOCTOR OF EDUCATION 

 
 
OR May OR August 

       December 201X 
 
 
 

 
 
 

Copyright 200X                    Tamara Alice Trojan 
 

 
 
 

 
         Page number not included 
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        SAMPLE TITLE PAGE FOR  
 

         DOCTOR OF MUSICAL ARTS 
 

YOUR TITLE IN CAPS; 
DOUBLE SPACED 

 
 

 
by 
 
 

Tamara Alice Trojan 
 
 
 
 

 
OR Musical Score 
OR Treatise 
 

 
A Dissertation Presented to the  

FACULTY OF THE USC THORNTON SCHOOL OF MUSIC 
UNIVERSITY OF SOUTHERN CALIFORNIA 

In Partial Fulfillment of the 
Requirements for the Degree 

DOCTOR OF MUSICAL ARTS 
(COMPOSITION)  

YOUR MAJOR IN CAPS 
 

       
        December 201X 

OR May OR August 
 

 
Copyright 200X                    Tamara Alice Trojan 
 

          
 
 
 

Page number not included 
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SAMPLE TITLE PAGE FOR DOCTOR  

 
OF PUBLIC ADMINISTRATION OR DOCTOR OF  

 
POLICY, PLANNING AND DEVELOPMENT  

 
 

 
 

 
by  
 

Tamara Alice Trojan 
 
 
 
 

 
 

 
A Dissertation Presented to the  

FACULTY OF THE USC SCHOOL OF POLICY, PLANNING, 
AND DEVELOPMENT  

UNIVERSITY OF SOUTHERN CALIFORNIA 
In Partial Fulfillment of the 

Requirements for the Degree 
DOCTOR OF PUBLIC ADMINISTRATION OR 

DOCTOR OF POLICY, PLANNING AND DEVELOPMENT  
 

 
 

       
     December 201X 

OR May OR August 
 
 
 

 
Copyright 200X                    Tamara Alice Trojan    

 
             
 

 
 
Page number not included 

YOUR TITLE IN CAPS; 
DOUBLE SPACED 
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SAMPLE TITLE PAGE FOR M.S. AND M.A. 
 

DEGREES CONFERRED BY THE GRADUATE SCHOOL 
 

YOUR TITLE IN CAPS; 
DOUBLE SPACED 
 

by  
 
 

Tamara Alice Trojan 
 

 
 

 
 

 
 

A Thesis Presented to the  
FACULTY OF THE USC GRADUATE SCHOOL 

UNIVERSITY OF SOUTHERN CALIFORNIA 
In Partial Fulfillment of the 

Requirements for the Degree 
                                       MASTER OF SCIENCE          MASTER OF ARTS 

   (MOLECULAR BIOLOGY)  
YOUR MAJOR IN CAPS 
    

       
     December 210X 

OR May OR August 
 
 
 
 
 

 
Copyright 200X                    Tamara Alice Trojan 

         
 
                 
 

 
 
 
Page number not included 
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SAMPLE TITLE PAGE FOR A MASTER OF FINE ARTS DEGREE 
 
 

 CONFERRED BY THE GRADUATE SCHOOL 
 

YOUR TITLE IN CAPS; 
DOUBLE SPACED 
 

by  
 
 

Tamara Alice Trojan 
 
 
 
 
 
 

 
A Thesis Presented to the  

FACULTY OF THE USC GRADUATE SCHOOL 
UNIVERSITY OF SOUTHERN CALIFORNIA 

In Partial Fulfillment of the 
   Requirements for the Degree 

             MASTER OF FINE ARTS 
       
     December 201X 

OR May OR August 
 

 
 
 
 
 
 
Copyright 200X                    Tamara Alice Trojan 

         
 
 
 
 
 

 
          Page number not included 
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SAMPLE TITLE PAGE FOR MASTER 

 
 OF BUILDING SCIENCE OR LANDSCAPE ARCHITECTURE  

 
OR HISTORIC PRESERVATION 

 
 

YOUR TITLE IN CAPS; 
DOUBLE SPACED 

 
 

by  
 
 

Tamara Alice Trojan 
 
 

 
 
 

 
 

A Thesis Presented to the  
FACULTY OF THE USC SCHOOL OF ARCHITECTURE 

UNIVERSITY OF SOUTHERN CALIFORNIA 
In Partial Fulfillment of the 

Requirements for the Degree 
MASTER OF BUILDING SCIENCE (or) 

MASTER OF LANDSCAPE ARCHITECTURE (or) 
MASTER OF HISTORIC PRESERVATION 

 
 
     December 201X 

OR May OR August 

 
 

 
 
Copyright 200X                    Tamara Alice Trojan 

  
 

 
 
Page number not included 
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SAMPLE TITLE PAGE FOR MASTER  
 

OF PUBLIC ART STUDIES 
 
 

YOUR TITLE IN CAPS; 
DOUBLE SPACED 

 
 

by  
 
 

Tamara Alice Trojan 
 
 
 
 
 
 
 

 
 

A Thesis Presented to the  
FACULTY OF THE USC ROSKI SCHOOL OF FINE ARTS 

UNIVERSITY OF SOUTHERN CALIFORNIA 
In Partial Fulfillment of the 

Requirements for the Degree 
MASTER OF PUBLIC ART STUDIES 

 
 
        December 201X 

OR May OR August 

  
 
 
 
 

Copyright 200X                    Tamara Alice Trojan 
         
   

 
                          Page number not included 
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SAMPLE TITLE PAGE FOR  

MASTER OF SCIENCE, EDUCATION;  

MASTER OF EDUCATION;  

MASTER OF MARRIAGE AND FAMILY THERAPY 

 
 

YOUR TITLE IN CAPS; 
DOUBLE SPACED 
 
 

by  
 

Tamara Alice Trojan 
 
 

 
 
 

 
A Thesis Presented to the  

FACULTY OF THE USC ROSSIER SCHOOL OF EDUCATION 
UNIVERSITY OF SOUTHERN CALIFORNIA 

In Partial Fulfillment of the 
Requirements for the Degree 

MASTER OF SCIENCE 
                                                   (EDUCATION)                  OR 
 

                     MASTER OF EDUCATION         OR 
 

MASTER OF MARRIAGE AND FAMILY THERAPY 
 

 
      December 201X 

OR May OR August 
 

 
Copyright 200X                    Tamara Alice Trojan 

 
 
 

      
Page number not included 
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SAMPLE TITLE PAGE FOR MASTER  
 

OF SCIENCE IN ENGINEERING 
 
 

YOUR TITLE IN CAPS; 
DOUBLE SPACED 
 

by  
 
 

Tamara Alice Trojan 
 
 
 
 

 
 

 
A Thesis Presented to the  

FACULTY OF THE USC VITERBI SCHOOL OF ENGINEERING 
UNIVERSITY OF SOUTHERN CALIFORNIA 

In Partial Fulfillment of the 
Requirements for the Degree 

MASTER OF SCIENCE 
(BIOMEDICAL ENGINEERING)  

YOUR MAJOR IN CAPS 
    

       
     December 201X 

OR May OR August 
 

 
 

 
Copyright 200X                    Tamara Alice Trojan 

 
 
 

 Page number not included 
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SAMPLE TITLE PAGE FOR MASTER  
 

OF SCIENCE IN GERONTOLOGY 
 
 

YOUR TITLE IN CAPS; 
DOUBLE SPACED 
 

 
by  
 
 

Tamara Alice Trojan 
 
 
 
 

 
 

A Thesis Presented to the  
FACULTY OF THE USC SCHOOL OF GERONTOLOGY 

UNIVERSITY OF SOUTHERN CALIFORNIA 
In Partial Fulfillment of the 

Requirements for the Degree 
MASTER OF SCIENCE 

(GERONTOLOGY)  
YOUR MAJOR IN CAPS 
    

       
     December 201X 

OR May OR August 
 

 
 

 
Copyright 200X                    Tamara Alice Trojan 

 
          
          
 
 

                                                                                                                          Page number not included 
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SAMPLE TITLE PAGE FOR MASTER OF MUSIC 
 

SCHOOL OF MUSIC 
 
 

YOUR TITLE IN CAPS; 
DOUBLE SPACED 
 

by  
 

Tamara Alice Trojan 
 
 
 
 
 
OR Musical Score 

 
 

A Thesis Presented to the  
FACULTY OF THE USC THORNTON SCHOOL OF MUSIC 

UNIVERSITY OF SOUTHERN CALIFORNIA 
In Partial Fulfillment of the 

Requirements for the Degree 
MASTER OF MUSIC 
(CHORAL MUSIC)  

YOUR MAJOR IN CAPS 
 

    December 200X 
OR May OR August 

  
 
 
 
 
 
 

Copyright 200X                    Tamara Alice Trojan 
 
 

Page number not included 
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SAMPLE TITLE PAGE FOR MASTER OF FINE ARTS  
 

IN INTERACTIVE MEDIA 
 
 

YOUR TITLE IN CAPS; 
DOUBLE SPACED 
 

 
by  
 
 

Tamara Alice Trojan 
 
 
 
 

 
 

A Thesis Presented to the  
FACULTY OF THE USC SCHOOL OF CINEMATIC ARTS 

UNIVERSITY OF SOUTHERN CALIFORNIA 
In Partial Fulfillment of the 

Requirements for the Degree 
MASTER OF FINE ARTS 
(INTERACTIVE MEDIA)  

YOUR MAJOR IN CAPS 
    

       
     December 201X 

OR May OR August 
 

 
 
 
 

 
Copyright 200X                    Tamara Alice Trojan 

 
 
 
 
 
Page number not included 
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SAMPLE TITLE PAGE FOR DOCTOR OF  
 

REGULATORY SCIENCE 
 

YOUR TITLE IN CAPS; 
DOUBLE SPACED 
 

 
by  
 
 

Tamara Alice Trojan 
 
 
 
 

 
 

 
A Dissertation Presented to the  

FACULTY OF THE USC SCHOOL OF PHARMACY 
UNIVERSITY OF SOUTHERN CALIFORNIA 

In Partial Fulfillment of the 
Requirements for the Degree 

DOCTOR OF REGULATORY SCIENCE 
    

       
     December 201X 

OR May OR August 
 

 
 
 
 
 
 
 

 
Copyright 200X                    Tamara Alice Trojan 

 
          

Page number not included 
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SAMPLE TITLE PAGE FOR MASTER ARTS  
 

IN TRADITIONAL OR SPECIALIZED JOURNALISM 
 
 

YOUR TITLE IN CAPS; 
DOUBLE SPACED 
 

 
by  
 
 

Tamara Alice Trojan 
 
 
 
 

 
 

 
A Thesis Presented to the  

FACULTY OF THE USC GRADUATE SCHOOL 
UNIVERSITY OF SOUTHERN CALIFORNIA 

In Partial Fulfillment of the 
Requirements for the Degree 

MASTER OF ARTS 
(JOURNALISM) OR 

(SPECIALIZED JOURNALISM)  
YOUR MAJOR IN CAPS 
    

       
     December 200X 

OR May OR August 
 
 
 

Copyright 200X                    Tamara Alice Trojan 
 
 
 
 
 
              
 Page number not included 

 

OR Professional Project 
OR Professional 
Multimedia Project
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APPENDIX E: 
HOW TO CREATE A MANUSCRIPT AS ONE DOCUMENT 

 
Note: The following is suggested and may not work for all programs.   
 
For WORD 2003 users only

 
a. With the cursor at the beginning of your document, select Insert>Page Numbers and uncheck 

the box “Show number on first page”. 
b. Click on the “Format” button and select “i,ii,iii” for Number format. Select “i” for Start at 

command (Title Page must be unpaginated).  
c. With the cursor at the end of your abstract (last page of roman numeral entry), select 

Insert>Break and chose “Section break types-Next page.” 
d. At the beginning of Chapter 1 or Introduction (right after the new section break that followed 

the abstract),select Insert>Page Numbers and check the box “Show number on first page”. 
e. Click on the “Format” button and select “1,2,3” for Number format. Select “1” for Start at 

command. You should have Roman numerals before the section break and Arabic numerals 
after the section break. 

 
For WORD 2007 users only

 
 

a. Starting at the beginning of the document, place the cursor on the first page where you want 
to display the page number in a different format.  

b. On the Page Layout tab, in the Page Setup group, click Breaks.  
 

 
c. Under Section Breaks, click Next Page.  
d. On the Insert tab, in the Header & Footer group, click Header or Footer, and then click 

Edit Header or Edit Footer to make changes in the header or footer area.  
The header or footer that contains the page number is labeled Section 2.  
 NOTE   If the header or footer is labeled First Page Header -Section 2- or First Page 
Footer -Section 2- and you want the header or footer on the first page of this new section 
to be the same as the header and footer on the rest of the pages in this section, clear the 
Different First Page check box in the Options group. 

e. Under Header & Footer Tools, on the Design tab, in the Navigation group, click Link to 
Previous to break the connection between the header or footer in the new section and 
the previous section.  

f. In the Header & Footer group, click Page Number, and then click Format Page Numbers.  
g. In the Number format list, click the format that you want, and if you want the numbering on 

this page to start with 1, type 1 in the Start at box, and then click OK.  

h. In the Navigation group, click Previous Section , and click in the header or footer that 
is labeled Section 1.  

i. In the Header & Footer group, click Page Number, and then click Format Page Numbers.  
j. In the Number format list, click the format that you want, and then click OK. 
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APPENDIX F: 
DEGREES CONFERRED BY THE UNIVERSITY 

 
Effective: Fall 2009 

 
Use for Title Page Heading, “Faculty of USC SCHOOL OF X” 
 
The following Degrees are under the jurisdiction of the Graduate School:  
 

• All Ph.D.’s (regardless of school, department) 
• Cinematic Arts: M.A. (Cinema-Television) 
• College: All Master’s Degrees 
• Communication: All Master’s Degrees, including Specialized Journalism 
• Dentistry: M.S. (Craniofacial Biology) 
• Fine Arts: M.F.A. (Fine Arts) 
• Health Professions (now School of Dentistry): All Master’s Degrees 
• Medicine: All Master’s Degrees {except M.S. (Molecular Epidemiology), M.P.A.P.  

(Physician Assistant Practice), and M.P.H. (Public Health)} 
• Music: M.A. (Early Music Performance) and M.A. (Music History and Literature) 
• Pharmacy: All Master’s Degrees  

 
For degrees under the jurisdiction of the Graduate School, an Appointment of Committee signed by the 
dean of the degree conferring school is required for the submission of the manuscript. Signature Pages will 
be signed and dated by the Vice Provost for Graduate Programs and Academic Affairs after the completion 
of the editing process.  The committee chair should not date the Signature Page.  
 
The following is a list of degrees conferred by other schools:  
 

• Architecture: M.B.S. (Building Science), M.H.P. (Historic Preservation), M.L.Arch. 
(Landscape Architecture) 

• Cinematic Arts: M.F.A. (Interactive Media ONLY).  
• Education: M.S. (Education), M.S. (Education – Counseling Psychology), Master of 

Education, Master of Marriage and Family Therapy, Master of Education, and Ed.D. 
• Engineering:  All M.S. Degrees 
• Fine Arts:  M.P.A.S. (Public Arts Studies, Fine Arts),  
• Gerontology: All Master’s Degrees.  
• Music: All M.M. and D.M.A. Degrees 
• Pharmacy: Doctor of Regulatory Science 
• Policy, Planning, and Development: D.P.A., D.P.D.D.   

 
An Appointment of Committee form is not required (although many schools require one at the academic 
unit level for internal use only).  The Signature Page should be signed and where applicable dated by the 
Dean of the conferring degree.  The Graduate School does not sign/date these Signature Pages.  
 
Please use the submission packet, including the Signature Page that corresponds to your major 
AND degree.  
 
http://www.usc.edu/schools/GraduateSchool/current_thesis_dissert_04.html 



35 
 

APPENDIX G: 
RULES GOVERNING PRE-PUBLISHED MATERIALS, COPYRIGHT,  

CO-AUTHORSHIP, & PROQUEST PUBLISHING OPTIONS  
 
1. MULTIPLE CHAPTERS (PRE-PUBLSIHED/PUBLICATION PENDING) DISSERTATIONS: 
  

a. Multiple paper dissertations are permitted, but you must treat the manuscript as one 
dissertation.  This includes: one title page, one table of contents page (covering all 
papers and sections within each paper), one abstract page, one list of tables and 
figures covering all tables and figures (if applicable) and one comprehensive 
bibliography covering all papers. You are permitted to have only one dedication and 
acknowledgements page.  

b.   Each paper can be a separate chapter provided that you have followed the rules 
above. 

c.   If you chose to have a separate abstract and bibliography per paper, you will still be      
required to submit an abstract and bibliography comprehensive to all papers.    

 
2: COPYRIGHT: 
  

a. All students retain the copyright to their work (hence the requirement that the 
copyright line be included on the title page).  You may formalize your copyright 
protection by paying ProQuest directly to file a claim of copyright on your behalf – 
(approximately $55, subject to change) with the Library of Congress or you may 
contact the Library of Congress directly for assistance.  

b. If you wish to include pre-published or pending-publication articles in your thesis or 
dissertation, you must provide ProQuest a copy of a permission letter from the 
publisher. 

c.   Questions related to the inclusion of copyrighted/protected images should be directed 
to ProQuest.  

d.   As the owner of copyright, students may publish their manuscript with any publisher 
(in addition to ProQuest).  

 
3: CO-AUTHORED CHAPTERS/PAPERS/SECTIONS:   

 
From the USC Catalog: 
 

A dissertation is an original contribution to current knowledge in the field and a 
demonstration that the Ph.D. candidate has achieved sufficient mastery in the 
field to pursue independent research and scholarship. A dissertation represents 
the individual candidate's research and writing. In fields where collaborative 
research has become the norm, the candidate is the sole author of the 
dissertation and specifies his or her contribution to the research and also 
delineates colleagues' contributions. 
   

a. A student may include co-authored sections/chapters in the dissertation as long as 
he/she is the SOLE author of the dissertation and can demonstrate his/her 
contributions and credit colleagues’ contributions. 

b. The following should be submitted to the Graduate School along with your 
dissertation paperwork:  

• Documentation about the various co-authors who contributed to the chapters, 
including status (student, faculty, other) and institutional affiliation. 

• The student will need to specify what his/her contributions to each chapter 
were and where applicable, clearly delineate the contributions of the 
colleagues. 
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• Verification from the dissertation chair that the dissertation conforms to the 
section in the Catalogue quoted above. 
 

4: PROQUEST PUBLISHING OPTIONS: 
 

When prompted by ProQuest during the uploading process, students will be given two 
publishing options.   

 
a. Traditional Publishing 
 

• Provided to the student at no cost.  Should someone be interested in viewing 
the entire manuscript, they (not the student) will be charged.  Under this option, 
ProQuest will provide a select number of the first few pages (will include blank 
pages) to interested readers. To view the manuscript in its entirety, charges will 
apply.  
    

a. Open Access Publishing 
 

• Students pay ProQuest $95 (subject to change at any time) to make the 
manuscript readily available to the public for viewing free of charge. This is in 
addition to other fees payable to USC and to ProQuest.   

 
If someone wishes to purchase a bound copy of the manuscript, he/she will need to purchase it 
directly from ProQuest. Authors may be entitled to royalties based on the percentage of sales.  
Contact ProQuest for terms and conditions.  
 
The Graduate School recommends the traditional publishing option. The USC Libraries 
provides an “open access” function at no cost.  The USC Libraries houses all manuscripts in 
USC’s Electronic Archives and makes them available (electronically) free of charge to interested 
parties (academic use only).  Contact the USC Libraries for terms and conditions.    
 
Students have the option to place restrictions on the availability of manuscripts published through 
ProQuest.  Contact ProQuest for more information.   

 
 

NOTE: The USC Publication Processing Fee ($115 for doctoral; $105 for Master’s) is required 
regardless of the publishing option a student selects from ProQuest.  This fee is formally known 

as the “Binding and Publication Fee.”
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APPENDIX H: 
SUPPLEMENTAL RULES GOVERNING THE SUBMISSION OF MUSICAL 
SCORES AND THE SUBMISSION OF MANUSCRIPTS IN JOURNALISM 

(These are supplemental rules; they do not replace the Guidelines) 
 
MUSICAL SCORES ONLY:  
 

Students who present musical scores are subject to the formatting guidelines with the following 
variations: 
 

1. Musical scores do not need to be divided into chapters. 
2. Musical scores can be presented and electronically submitted on paper larger than the 

standard 8 ½ by 11 as long as the document is one PDF file.  
3. Musical scores contain different elements than a traditional manuscript. See chart below. 

 

Order  Element  Required­
Optional 

Pagination  Table of 
Contents Entry  

1  Title Page  Required unnumbered No
PRELIMINARY  PAGES 

2  Epigraph  Optional If first page, start with small 
Roman numeral ii (preliminary 
pages use Roman numerals) 

Yes

3  Dedication  Optional Small Roman numeral  Yes
4  Acknowledgments  Optional Small Roman numeral  Yes
5  Table of Contents  Required Small Roman numeral  No
6  Abstract  Required Small Roman numeral  Yes
7  Program Note  Optional Small Roman numeral  Yes
8  Instrumentation  Optional Small Roman numeral  Yes
9  Preface  Optional Small Roman numeral  Yes

MAIN PAGES/BODY 
10  Main Body/Musical Score Required First page of introduction or first 

chapter starts with Arabic no. 1  
Yes

11  Glossary  Optional Arabic numeral Yes
12  Alphabetized Bibliography Optional Arabic numeral Yes
13  Appendices  Optional Arabic numeral Yes

 

 
 
MASTER’S  SUBMISSIONS IN JOURNALISM ONLY:  
 
Students in the specialized journalism program are bound by the existing Guidelines. All the 
specialized journalism submissions will be called a “thesis” and all will have a bibliography.   
 
Students in the traditional journalism program are bound by the existing Guidelines.  The 
bibliography requirement is dependent on the type of work submitted.   
 

• For students in the traditional journalism program who are writing a thesis or a 
professional multimedia project, a bibliography is required. 

• For students in the traditional journalism program who are writing a professional 
project, a bibliography is not required. 

 
The “presentation line” on a title page will dictate whether you are required to submit a 
bibliography.  However, note that ALL manuscripts submitted without a bibliography will be 
subject to verification by the Graduate School in consultation with the student’s 
committee chair.   



38 
 

 
APPENDIX I: 

CONTACT INFORMATION AND TECHINICAL SUPPORT 
(Editing and Submission Questions) 

 
USC GRADUATE SCHOOL 
 

• 213.740.9033 
• Thesis Editors: thesised@usc.edu (email contact strongly recommended). 
• http://www.usc.edu/schools/GraduateSchool/current_thesis_dissert.html 

  
USC LIBRARIES 

• Direct all questions/uploading inquiries to dim@usc.edu 
• USC Libraries, Digital Archives: http://digitallibrary.usc.edu 

 
The Graduate School does not administer the USC Libraries site and cannot answer any technical 
questions.   
 
PROQUEST 
 

Technical Assistance, Including Formatting Tips and Resources: 
• 877.408.5027  
• Available 9am‐6pm E.S.T. Monday through Friday (excluding U.S. holidays)  
• http://dissertations.umi.com/usc  

  
 Click on “Resources & Guidelines,” in particular “Online Submission: Frequently 
Asked Questions.”  

• http://www.etdadmin.com/cgi­bin/main/faq 
 

A list of commonly asked formatting questions.  

Questions about Payment or Ordering Hard Copies [see FAQ online] 

• 800.521.0600 ext. 7020  
• Available 8am‐5pm E.S.T. Monday through Friday (excluding U.S. holidays)  

 
The Graduate School does not administer the ProQuest site and cannot answer any questions related 
to its operation.  

Mailing Address: 

ProQuest 
Customer Service 
789 E. Eisenhower Parkway 
P.O. Box 1346 
Ann Arbor, MI 48106‐1346 
 
 
 

The USC Guidelines take precedent over other formatting guidelines. 


